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| Introduction

Introduction
Dell� UPS Management Software supports either an individual computer or network‐connected
computers [including both local area networks (LANs) and the Internet].

The software monitors the UPS and safeguards computer systems from uncontrolled shutdowns due to
power failure. With the Dell UPS Management Software, you can monitor and configure the UPS on
any computer within the same LAN. One UPS can provide multiple computers in a network with
simultaneous power management, including system shutdown, saving application data, and shutdown of
the UPS when utility power fails.

Dell UPS Management Software Components

Dell UPS Management Software has three components:

� The Agent is the core component of the Dell UPS Management Software and runs in the
background as a system service. It communicates with the UPS, logs events, notifies users of
events, arranges actions according to the user's specifications, and initiates shutdown when
necessary. The Agent can be managed by the Monitor.

� The Monitor is the user interface application of the Dell UPS Management Software. Relying on the
Agent, it gathers real‐time UPS information, UPS status, and server information, and allows the
user to tailor the UPS working parameters. The Monitor can run on any computer on the LAN or
on a standalone computer.

� The Tray Icon is the management tool of the Dell UPS Management Software, and it appears in the
status area of the system task bar. The Tray Icon is available only for the Microsoft® Windows®

platform.

The Tray Icon uses two different icons to display the current Agent status (see Table 1):

Table 1. Tray Icon

Agent is running.

Agent is stopped.

1
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Right click the Tray Icon to display a shortcut menu (see Figure 1). Use the shortcut menu to start and
stop the Agent or Monitor.

Figure 1. Tray Icon Shortcut Menu

Figure 2 shows the relationships between the software components and the UPS.

UPS

AgentMonitor

Tray Icon

Figure 2. Relationship Between Software Components and UPS
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Dell UPS Management Software Applications

Figure 3 shows the software application with a standalone computer.

Communication Cable

Software UPS

Power Supply Cable

Figure 3. Standalone Computer Application

Figure 4 shows the software application with a LAN.

Software UPS Software UPS Software UPS

Power Supply Cable

Communication Cable

Network Cable

Hub

Figure 4. LAN Software Application
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Figure 5 shows the software application with the Internet.

Software UPS Software UPS Software UPS

Hub

Hub

Router

Power Supply Cable

Communication Cable

Network Cable

Software UPS Software UPS Software UPS

Router

Figure 5. Internet Application
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Features

The Dell UPS Management Software has the following features:

� Runs continuously to protect the equipment after the Agent starts.

� Uninstalls easily and completely.

� Provides a panoramic view of all information, including utility power, UPS, load, and battery status,
all in the same window.

� Automatically searches and remotely monitors any Dell UPS on the LAN.

� Manually searches and remotely monitors any Dell UPS on the Internet.

� Provides security protection with an administrator password. Only the system administrator has full
access; other users have only view access.

� Protects data automatically by closing open applications and saving the related files.

� Turns the UPS on and off, providing maximum protection for your computer system.

� Initiates a UPS self‐test.

� Supports Simple Network Management Protocol (SNMP) monitoring.

� Shuts down the network.

� Logs data and events (including utility power, UPS, load, and battery status) so the system
administrator can perform daily system maintenance.

� Provides flexible methods of notifying users of UPS status, including:

- Broadcasting messages to all users in the network.

- Sending messages to a pager.

- Sending messages by e‐mail.

- Sending messages to a mobile phone with Short Message Service (SMS).
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Installation

System Requirements
� A minimum of 128 MB of physical memory (256 MB is recommended)

� A minimum of 160 MB of hard disk space

� More than 256 colors and 800 x 600 resolution or above display is recommended

� Administrator credentials (for Microsoft Windows Vista® and Windows 7 operating systems)

� Superuser credentials for Linux® operating systems

� TCP/IP communication protocol installed to support network management

� An available communication port (RS‐232 serial port or USB port)

Platforms supported by Dell UPS Management Software include:

� Microsoft Windows Server® 2008, Standard Edition

� Microsoft Windows Server 2008, Standard x64 Edition (includes Hyper-V�)

� Microsoft Hyper-V Server 2008 R2

� Microsoft Windows Storage Server 2008, Standard Edition

� Microsoft Windows Server 2003 R2, Standard Edition

� Microsoft Windows Server 2008 R2, Standard x64 Edition

� Microsoft Windows Small Business Server 2003 R2

� Microsoft Windows Small Business Server 2008

� Red Hat® Enterprise Linux

� Novell® SUSE® Linux Enterprise Server

� Microsoft Windows XP® Professional

� Microsoft Windows XP Home

� Microsoft Windows Vista Home Premium

� Microsoft Windows Vista Business

� Microsoft Windows Vista Ultimate

� Microsoft Windows 7 Professional x32, x64

� Microsoft Windows 7 Ultimate

� Ubuntu® Linux

2
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Installing the Software

This section includes installation instructions in a graphical user interface (GUI) environment and a
console environment.

Installing in a GUI Environment

To install the software in a GUI environment:

1 For a Microsoft Windows operating system, run setup.exe from the CD drive: \Windows directory
to start the installation program (see Figure 6).

Figure 6. Setup Icon

NOTE: In the Microsoft Windows Vista and Windows 7 operating systems, you are prompted to enter the

administrator account information.

For other operating systems, enter the command:

./setup.bin

or

setup_console.bin (see Figure 7).

Figure 7. setup.bin
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2 Select the language for the software and click OK (see Figure 8).

Figure 8. Selecting the Language for Installation

3 Read the introduction and click Next (see Figure 9).

Figure 9. Introduction Window
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4 If there is a previously installed version of the Dell UPS Management Software, the software
prompts you to remove it. Click Yes to remove the software and continue with the installation
(see Figure 10).

Figure 10. Removing the Previous Software Version

5 The software provides an option to keep the previous software configuration parameters, such as
local UPS information, Network Management Card settings, shutdown parameters, and alarm
settings. Click Yes to keep the previous configuration file; otherwise, click No.

Figure 11. Saving the Previous Configuration Parameters
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The software begins uninstalling the software (see Figure 12).

Figure 12. Uninstalling the Software

6 By default, the software installs to C:\Program Files\Dell\UPS Management Software. Update the
location if needed and click Next (see Figure 13).

Figure 13. Choose Install Folder Window
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7 Select the shortcut folder and click Next (see Figure 14).

Figure 14. Choose Shortcut Folder Window
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8 Review the selected installation options. If the options are correct, click Install to begin the
installation (see Figure 15).

Figure 15. Pre-Installation Summary Window



18
 

| Installation

The Installing window displays (see Figure 16).

Figure 16. Installing Window
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9 When the installation program is complete, click Done to exit the installer (see Figure 17).

Figure 17. Install Complete Window

If the software installed successfully, the Dell UPS Management Software application can be found in
All Programs from the Start menu (see Figure 18).

Figure 18. Dell UPS Management Software Application in the Start Menu
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Installing in a Console Environment

To install the software in a console environment:

1 To start the installation program, enter the directory appropriate for the system and enter the
command:

setup_console.bin

2 Read the provided information and press Enter to continue the installation.

3 Review the selected installation options. If the options are correct, click Install to begin the
installation.

4 When the installation program is complete, click Done.

5 Reboot the system to activate the software.

The installation program stores the Dell UPS Management Software run environment variables in
/etc/profile.

Starting the Software

This section includes startup instructions for Microsoft Windows and Linux operating systems.

Software Startup in a Microsoft Windows Operating System

To start the software in a Microsoft Windows operating system:

1 Start the Agent using one of the following methods:

� Set the Agent to start automatically at computer startup.

� Select Start menu > All Programs > Dell UPS Management Software to start the Tray Icon
and Agent (see Figure 19).

Figure 19. Starting the Tray Icon and Agent



21
 

Installation |

2 Start the Monitor. Right click the Dell UPS Management Software Tray Icon and select Start
Monitor (see Figure 20).

Figure 20. Starting the Monitor

3 For Microsoft Windows Vista, Windows 7, and Windows Server 2008 operating systems, complete
Steps 4 and 5.

4 Right click the Dell UPS Management Software Tray Icon and select Exit.

5 Restart the computer to restart the Dell UPS Management Software.

If you have administrator privileges, you can restart the Dell UPS Management Software without
restarting the computer:

� To start the Agent, select Start menu > Control Panel > Administrative tools > Services,
and find the service UPSMSmonitor. Right click UPSMSmonitor and select Start.

� To start the Tray Icon, select Start menu > All Programs > Dell UPS Management
Software.

Software Startup in a Linux Operation System

To start the software in a Linux operating system:

1 The Agent starts automatically at system boot. If not already started, from the /opt/UPS directory,
enter the command:

./agent start

2 Start the Monitor. From the /opt/UPS directory, enter the command:

./monitor
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Uninstalling the Software

This section includes uninstall instructions for Microsoft Windows and Linux operating systems.

Uninstalling in a Microsoft Windows Operating System

To uninstall the software in a Microsoft Windows operating system:

1 Exit all Dell UPS Management Software programs.

2 Stop the Agent. Right click the Dell UPS Management Software Tray Icon and select Stop Agent
(see Figure 21).

Figure 21. Stop Agent

3 Exit the software. Right click the Dell UPS Management Software Tray Icon and select Exit
(see Figure 22).

Figure 22. Exit

4 Begin uninstalling the software one of the following ways:

� Select Start menu > All Programs > Dell UPS Management Software > Uninstall Dell
UPS Management Software (see Figure 23).
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Figure 23. Uninstall Dell UPS Management Software

� Select Start menu > Control Panel > Add/Remove Program. Select the Dell UPS
Management Software and click Change/Remove (see Figure 24).

Figure 24. Add or Remove Programs
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5 The Uninstall Program window opens (see Figure 25). Click Uninstall to continue.

Figure 25. Uninstall Dell UPS Management Software Window
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The uninstalling process begins (see Figure 26).

Figure 26. Uninstall Progress
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6 After the Dell UPS Management Software uninstalls completely, click Done (see Figure 27).

Figure 27. Uninstall Complete Window

Uninstalling in a Linux Operating System

To uninstall the software in a Linux operating system:

1  Stop the Agent. From the /opt/UPS directory, enter the command:

./agent stop

2 Open the Terminal and enter the /opt/UPS directory.

3 Enter the command:

./Uninstall
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About the Software
This chapter describes the Dell UPS Management Software window and how to set preferences for the
software.

The Dell UPS Management Software Window

Select Start Monitor from the Tray Icon or select Dell UPS Management Software from the program
list to open the Dell UPS Management Software window, which displays a list of all Agents within the
LAN.

The tree view on the left side of the window displays a hierarchical list of items, such as Root, network
names, SNMP, the Agents, the communication port, and the UPS models (see Figure 28). By clicking
an item, you can expand or collapse the associated list of sub‐items.

Figure 28. Dell UPS Management Software Window

3
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Selecting one of the UPS models displays details about the UPS on the right side of the window
(see Figure 29).

The UPS status diagram is a graphical representation of the UPS power status. The diagram shows the
AC Line, UPS, Load, Battery, and Bypass (if the UPS is on bypass). The data boxes for both the UPS
and Load have multiple pages. Click the data table to go to the next page.

The UPS state displays at the top of the window.

The last two events display at the bottom of the window.

Figure 29. Data Boxes with Multiple Pages
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Setting Software Preferences

You can customize the window appearance, specify the date format, and select a local language.

Changing the Window Appearance

Select Background Image from the Preferences menu to change the appearance of the main window
(see Figure 30).

Figure 30. Changing the Appearance
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You can select one of the following for the background of the main window:

� None: Default gray background.

� Color: Uniform color background.

� Gradient: One color from light to dark.

� Text: Repeating text.

� Grid: Repeating image.

� Picture: Single image.

For example (as shown in Figure 31), select Color to change the background from the default gray to
the color defined in the Advanced Settings.

You can customize your selection of the background (see “Changing Advanced Settings” on page 32).

Figure 31. Changing the Background Color
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Changing the Date Format

Select Date Format from the Preferences menu to change the date format. The date options are:
Year/Month/Date, Month/Date/Year, or Date/Month/Year (see Figure 32).

Figure 32. Changing the Date Format
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Changing Advanced Settings

Select Advanced Settings from the Preferences menu. The Advanced Settings window opens
(see Figure 33).

Figure 33. Advanced Settings Window – General Tab
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Use the Advanced Settings window to change the appearance of the interface text and customize the
selected background image.

On the Advanced Settings – General tab view, you can change the color of the regular text and the
warning text. You can also change the font and text size from the Font lists (see Figure 33).

On the Advanced Settings – Background Image tab view, you can select and customize the image
background.

NOTE: To add pictures to the Picture drop-down list box, paste the image file in the images folder. The default

folder location is C:\Program Files\Dell UPS SW\images.

NOTE: Clicking the Default button returns the parameters to the default values.

Figure 34. Advanced Settings Window – Background Image Tab
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Changing Languages

To change the language of the interface display text, select the Language menu and then one of the
languages: English, Traditional Chinese, Simplified Chinese, German, French, Spanish, Russian,
Japanese, or Korean (see Figure 35).

Figure 35. Selecting the Language for the Interface
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Configuring the Software
NOTE: You must log in as administrator through the System menu to change any settings or the settings will not

be saved or implemented.

This chapter explains how to:

� Auto‐search for a UPS

� Modify the password

� View and set up the Event Log and Data Log

� Configure actions for events, such as broadcasting a message, e‐mailing a message, sending a text
message, or sending a page

� Reset the Dell UPS sensor values

� Control the UPS load segments

� Rename the UPS model

� Configure shutdown parameters

� Set the UPS warranty period

� Perform and schedule a UPS self‐test

� Perform and schedule a UPS on/off task

� Remotely monitor any Dell UPS within the same LAN or on the Internet

� Reboot computers on the LAN

� Export configuration parameters

4
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Auto-Searching the UPS

Click Auto Search UPS from the System menu to search for the UPS connected to the computer's serial
port (see Figure 36). The search result displays in the tree view (see Figure 37).

Figure 36. System Menu

Figure 37. Search Results
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Clicking an item in the tree view displays the following information (see Figure 38):

� All computers in the LAN that are running the Dell UPS Management Software Agent.

� The UPS communication port.

� The model type of the UPS to which the Agent is connected.

� The current status of the selected Agent.

NOTE: Select a UPS model to display details about the UPS (see Figure 29 on page 28).

Figure 38. Details of Selected Tree View Item

NOTE: The first time the Agent starts requires more time than subsequent startups to communicate with the

UPS. The software keeps a record of UPS information and, after the first startup, the software starts according

to the last record. If the COM port, USB port, UPS model, or IP address changes, click Auto Search UPS from

the System menu to retrieve the new UPS information.

For Linux platforms, the software cannot auto‐detect the serial port devices. If the system has a serial
port not listed in the default setting table, you must add it manually. Table 2 shows the default serial
port device settings.

Table 2. Default Serial Port Device Settings

Platform Serial Port Device

Linux /dev/ttyS0 /dev/ttyS1
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To manually add a serial port:

1 Select COM Port Setting from the System menu.

The Communication Port Settings window opens (see Figure 39).

Figure 39. Communication Port Settings Window

2 Enter the serial port device setting and click Add.

3 Click OK to save and exit.

To remove a communication port, select the device name and click Remove.
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Modifying the Password

To modify the password:

1 Log in as the administrator.

2 Select Act as Administrator from the System menu. Enter the administrator password and click
OK (see Figure 40).

NOTE: The default password is admin.

Figure 40. Administrator Password

If the password is not correct, the system displays an error message (see Figure 41).

Figure 41. Error Message
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3 Select Modify Administrator Password from the System menu. The Administrator Password
Settings window opens (see Figure 42).

Figure 42. Administrator Password Settings Window

NOTE: Only a Superuser on a local machine can set the administrator password. If you are not a

Superuser, the Administrator window opens first, prompting you to log in as an administrator.

4 Enter a new password in the New Password field.

5 Reenter the new password in the Confirm Password field.

6 Click OK.

7 If the password is not the same, an error message displays. Reenter the password in both fields and
click OK.
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Viewing the Event Log

The Event Log Viewer displays the UPS event history (see Figure 43).

You can view the Event Log one of the following ways:

� Select Event Log from the Logs menu.

� Click the  icon from the toolbar.

� Click the View Log button in the Event Log area of the Record Setting window (see Figure 45 on
page 43).

Figure 43. Event Log Viewer

Click the Next, Prev, Home, and End buttons to navigate to different pages. To remove selected Event
Log items, select the Delete check box for each item and click Delete. To delete all events, click Purge
All. To copy the log to a file, click Export.Click Close to exit the window.
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Viewing the Data Log

The Data Log Viewer displays UPS data records (see Figure 44).

You can view the Data Log one of the following ways:

� Select Data Log from the Logs menu.

� Click the  icon from the toolbar.

� Click the View Log button in the Data Log area of the Record Setting window (see Figure 45).

Figure 44. Data Log Viewer

Click the Next, Prev, Home, and End buttons to navigate to different pages. To remove selected Data
Log items, select the Delete check box for each item and click Delete. To delete all data, click Purge
All. To copy the log to a file, click Export. Click Close to exit the window.
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Setting Event and Data Log File Parameters

Use the Record Setting window to set the parameters for the log files. Select Record Setting from the
Logs menu. The Record Setting window opens (see Figure 45).

Figure 45. Record Setting Window

NOTE: Clicking the Default button returns the parameters in this view to the default values. If the OK button is

disabled, the current Agent is read‐only, and you cannot set up the parameters. You may log in as a Superuser

through the Act as Administrator menu.

Table 3 lists the log options and parameters.

Table 3. Log Options and Parameters

Parameter Unit Maximum Value Minimum Value Default Value

Maximum File Length (Event Log) Rows 10,000 20 600

Maximum File Length (Data Log) Rows 10,000 20 10,000

Record Interval Seconds 3,600 1 60

The View Log buttons open the Event Log or Data Log. See “Viewing the Event Log” on page 41 or
“Viewing the Data Log” on page 42 for more information.

The Settings button opens the Event Action window. See the following section, “Configuring Event
Actions,” for more information.
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Configuring Event Actions

Select Event Action from the UPS menu, or click the  icon from the toolbar, or click the Settings
button in the Record Setting window. The Event Action window opens (see Figure 46).

Figure 46. Event Action Window

You can select which actions should be performed when specific events occur:

� Record – Select the events to be recorded in the Event Log and select the Record check box. All
events can be recorded in the Event Log.

� PC Beep – Select the events to initiate an audible beep on your computer and select the PC Beep
check box. Only these events can be configured: Communication Lost, On Bypass, AC Fail, UPS
Battery Low, and UPS Output Overload. The PC Beep feature is available only for Microsoft
Windows platforms.
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� Pop‐up warning – Select the events to open a message window on your computer and select the
Pop‐up warning check box. Only these events can be configured: UPS Battery Low,
Communication Lost, Communication Established, On Bypass, AC Fail, AC Restore, System to be
shut down, System to be shut down by another Agent, and Warranty Period has expired. The
Pop‐up Warning feature is available only for Microsoft Windows platforms.

� Broadcast – Select the events to be broadcast to the configured users and select the Broadcast
check box. All events can be broadcast. Continue to “Broadcasting a Message” on page 46 to
complete the configuration.

� E‐mail – Select the events to send an e‐mail to the configured recipients and select the E‐Mail
check box. All events can be e‐mailed. Continue to “Sending Event Messages by E‐Mail” on
page 49 to complete the configuration.

� Send SMS – Select the events to send a text message to the configured mobile phones and select
the Send SMS check box. Continue to “Sending Event Messages by Mobile Phone” on page 55 to
complete the configuration.

� Send Page – Select the events to send a page to the configured pagers and select the Send Page
check box. Only these events can be configured: UPS Battery Low, UPS Hardware Failure, UPS
Input Power Failure, and UPS Output Overload. Continue to “Sending Event Messages by Pager”
on page 57 to complete the configuration.
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Broadcasting a Message

NOTE: Broadcasting is available only on the Microsoft Windows platform versions that include Messenger

Service. Messenger Service is not included with Windows Vista, Windows 7, and Windows Server 2008. Users

must have Messenger Service enabled on their computer to receive broadcast messages.

Select Broadcast Setting from the Tools menu or click the Setting button for Broadcast in the Event
Action window. The Broadcast Message Settings window opens (see Figure 47).

Figure 47. Broadcast Message Settings Window
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The Broadcast To area of the window lists the users who can be selected to receive broadcast messages,
including all users, domain users, and specific users.

� All Users – Sends the message to all computers that are in the same network with the local Agent,
whether or not the computer is in the same domain.

� Domain User – Sends the message only to all computers in the same domain with the local Agent.

� Specific User – Sends the message only to one or a group of defined users, but no others.

To add a new user:

1 Click Add to open the Add Broadcast User window (see Figure 48).

Figure 48. Add Broadcast User Window

2 Enter the username that will receive messages and click OK.

The names of the added users are shown in the Broadcast To area of the window.



48
 

| Configuring the Software

To configure the broadcast settings (see Figure 49):

1 Select the user who will receive messages.

2 Select the events that will be sent to the user.

3 Click OK.

The settings are effective immediately.

Figure 49. Broadcast Message Settings

To remove a user, select the username and click Remove.

NOTE: The All Users and Domain User items cannot be deleted.
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Sending Event Messages by E‐Mail

NOTE: To send e‐mail messages when an event occurs, the computer with the Dell UPS Management Software

installed must be connected to the Internet.

Select E‐mail Setting from the Tools menu or click the Setting button for E-mail in the Event Action
window. The E‐Mail Settings window opens (see Figure 50).

Figure 50. E-Mail Settings Window
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To configure the e‐mail settings:

1 Enter the SMTP server settings:

Parameter Description

SMTP Server Enter the IP address (IPv4 address or IPv6 address) of the SMTP mail server that
will be used to send e‐mail to the selected users.

SMTP User Enter the SMTP mail server login name with the complete address format. For
example, yyy@test.com.cn

Password If a password is required for the SMTP server, select the check box and enter the
password for the account.
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2 Enter the sender name and telephone number.

3 To send a daily e‐mail at a specific time, select the check box and enter the time of day in 24‐hour
format (see Figure 51). The e‐mail contains two attachments: the Event Log and Data Log files for
the preceding 24 hours.

Figure 51. Sender Information
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4 Select the Add button (see Figure 52). The Add Receiver E‐mail Address window opens
(see Figure 53).

Figure 52. Add Button
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Figure 53. Add Receiver E‐mail Address Window

5 Enter the receiver's e‐mail address and click OK to save and exit.

6 Dell recommends testing the e‐mail function by selecting the e‐mail address and clicking the Test
button. The software sends a test e‐mail to the specified recipient.

NOTE: You can select the event messages from the E‐Mail Settings window or from the Event Action

window.

7 Verify that one or more recipient e‐mail addresses are selected, and then select the event messages
to be sent by selecting the message check box (see Figure 54).
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Figure 54. E-Mail Recipient and Message Selection

If the selected event occurs, the software sends the e‐mail to all of the selected addresses in the
Receiver E‐Mail list.

8 Click OK to save and exit.

To remove a recipient, select the e‐mail address and click Remove.
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Sending Event Messages by Mobile Phone

NOTE: Sending local SMS text messages requires that the computer with the Dell UPS Management Software

must have at least one communication port that is connected to a GSM modem or mobile phone.

Select SMS Setting from the Tools menu or click the Setting button for Send SMS in the Event Action
window. The SMS Setting window opens (see Figure 55).

Figure 55. SMS Setting Window
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To configure the SMS settings:

1 Select the communication port that is being used by a GSM modem or mobile phone
(see Figure 56).

2 Set the baud rate for the communication port.

3 If you are located outside of Mainland China, select Other for Locus.

Figure 56. SMS Setting Window with Selections

4 In the Receiver list, enter up to five mobile telephone numbers to receive a text message. Enter
only numbers with no spaces, alphanumeric characters, or symbols.

5 Dell recommends testing the SMS function by selecting a telephone number and clicking the Test
button. The software sends a test text message to the specified recipient.

NOTE: You can select the event messages from the SMS Setting window or from the Event Action

window.
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6 Select the event messages to be sent by selecting the message check box. If the selected event
occurs, the software sends the message to all of the telephone numbers in the Receiver list.

7 Click OK to save and exit.

To remove a recipient, select the telephone number and click Remove.

Sending Event Messages by Pager

NOTE: Sending a page when an event occurs requires that the computer with the Dell UPS Management

Software must have at least one communication port that is connected to a modem.

Select Pager Setting from the Tools menu or click the Setting button for Send Page in the Event Action
window. The Pager Setting window opens (see Figure 57).

Figure 57. Pager Setting Window
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1 Enter the applicable pager settings:

Parameter Description

Modem Port Select the communication port that is being used by the modem.

Access Number Some pager services require a delay between dialing the access number and the
message code. The Access Number is the station number that the pager joined
(which can only be an auto station). The waiting time is the delay time between
dialing the paging station number and the pager number; the delay time is set by
the paging station. For example, the Liantong 192 auto station requires a one
second delay.

Pager Number Some pager services require a delay between dialing the pager number and the
message code. The Pager Number is the number of the pager that accepts the
communication. The wait time is the delay time between dialing the pager number
and the message code (paging message content); the delay time is set by the paging
station. For example, the Liantong 192 auto station requires a one second delay.

Dialing number to external
line

For an external line, dial a specified number and delay a specified time to access
the external line. If the external line phone number cannot be dialed directly, add
the switch number in the Dialing to external line field. The wait time after dialing
can be set as needed, generally one second.

Dialing number after
message

Some pager services require a specific number to end the message code.

2 Dell recommends testing the pager function by clicking the Test button. The software sends a test
page (000) to the specified recipient.

NOTE: You can select the event messages from the Pager Setting window or from the Event Action

window.

3 Select the Event Code check boxes for the event messages to be sent (see Figure 58). Only these
events can be configured: UPS Input Power Failure, UPS Battery Low, UPS Hardware Failure, and
UPS Output Overload.

If the selected event occurs, the software sends the event code to the pager. The event code
displays on the pager.
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4 Click OK to save and exit.

Figure 58. Pager Setting Window
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Resetting the Dell UPS Sensor Values

Select UPS Control Parameters from the UPS menu. The UPS Control Parameters window opens
(see Figure 59).

NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control

commands are restricted to the LCD only. This setting must be enabled from the LCD before you can select UPS

Control Parameters.

Figure 59. UPS Control Parameters Window

To reset the sensor values:

1 Select the check box for the options to reset:

� Reset Peak Consumption Watts

� Reset Cumulative Consumption Watts

� Reset Peak Headroom Watts

2 Click OK.

The sensor values clear, and the date and time stamp for the statistic resets to the current date and
time.
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Setting up UPS Load Segment Control

The Load Segment Control window contains parameters to control each UPS load segment. Select
Load Segment Control from the UPS menu to open the Load Segment Control window
(see Figure 60).

NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control

commands are restricted to the LCD only. This setting must be enabled from the LCD before you can select Load

Segment Control.

Figure 60. Load Segment Control Window

The parameters include:

� Minimum battery charge level: Shuts down the selected load segment when the battery capability
is below its set percentage value.

� Shutdown Timer: Shuts down the selected load segment when the utility power fails for the
amount of time equal to the setting time. The value range is ‐1 to 32,767 seconds.

� Startup Timer: Starts up the load segment when the set timer expires after utility power is
restored. The value range is ‐1 to 32,767 seconds.

� Manual Shutdown: Shuts down the load segment immediately.

� Manual Startup: Starts the load segment immediately.
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To configure the load segment:

1 Select the load segment to configure, or select the check box for Apply to All Load Segments.

2 Set the shutdown and startup parameters.

3 Click OK to save and exit.

Renaming the UPS Model

Select UPS Alias Information from the UPS menu to open the UPS Alias Information window
(see Figure 61).

Figure 61. UPS Alias Information Window

NOTE: If the Dell UPS Management Software automatically detects the UPS model, you cannot rename it.

Select the UPS Model from the drop‐down menu. You can rename the UPS by selecting the Rename
UPS check box and entering an alias for the UPS name.
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Configuring Shutdown Parameters

Select Shutdown Parameter from the UPS menu or click the  icon from the toolbar to open the
Shutdown Settings window (see Figure 62).

Figure 62. Shutdown Settings Window

NOTE: The System checkbox is checked by default if software detects a UPS connected to the server through

RS-232 or USB.
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NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control

commands are restricted to the LCD only. A read-only access message displays when you click OK

(see Figure 63). You must enable this setting from the LCD before you can apply changes to the Shutdown

Settings window.

Figure 63. UPS is Set to Read-Only Message

NOTE: If the Agent is connected to more than one UPS, each UPS has its own shutdown conditions.

The shutdown parameters are:

Parameter Description

Allow battery to discharge for The time that the UPS battery is able to supply power when utility power
fails.

Shut down when remaining battery
time is below

When the remaining battery time falls below the specified time, the
output of the UPS turns off. The battery time range is 0 to 4320 minutes,
59 seconds. The default value is 2 minutes, 0 seconds.

Begin shutdown immediately if
Battery Low

When a Battery Low event occurs, the Agent shuts down the UPS
immediately; otherwise, the shutdown time is controlled by the battery
backup time.

System Shutdown The system shuts down while the selected UPS is being turned off.

System Suspend The system is suspended to disk during the shutdown sequence. This
function is available only on certain Microsoft Windows platforms, and
Hibernate Support must be enabled from the Control Panel (Control
Panel > Power Options > Hibernate).

Redundant UPS Input Setting If there is a redundant UPS supplying power to the local Agent, you can
safely shut down the local Agent before all UPSs shutdown. See
“Redundant UPS Shutdown” on page 69 for more information.

Time needed for system shutdown The time required to shut down the system, from the initiation of
shutdown until it is complete.

Powered by The Load Segment that powers the computer.

Remote Shutdown by Agent Allows another Agent to shut down the selected UPS.

XX min shut down system After receiving the specified Agent's shutdown signal, shutdown is delayed
by XX minutes.
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Parameter Description

Run Command File before
Shutdown

Before system shutdown, the Agent can initiate a command if this
parameter is not zero. The Agent does not begin to shut down the system
until the ”Execute file before system shutting down” ends.

Shutdown File Max Execution
Time

Before system shutdown, the time required to implement the shutdown
file.

Shutdown Conditions Displays the remote Agents to be shut down. You can add, modify, or
remove the remote Agents.

Shutdown Alarm Interval The number of minutes between each shutdown warning.

Start Warning before Scheduled
Shutdown

The time in minutes before a scheduled shutdown when the Agent issues
the first warning.

Remote Shutdown by Agent

To configure for shutdown by a remote Agent:

1 Select the Remote Shutdown by Agent check box and click Add.

2 Enter the IP address (IPv4 address or IPv6 address) or host name of the Agent.

3 Click OK to save and exit.

When the local Agent receives the specified Agent's shutdown signal, the system shuts down in the
specified delay time.
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Shutdown Remote Agents

To configure for shutting down remote Agents:

1 Click the Add button in the Shutdown Conditions area.

The Shutdown Remote Agents window opens (see Figure 64).

Figure 64. Shutdown Remote Agents Window

2 Select Shutdown or On Battery:

When the UPS of the Agent is going to shut down and Shutdown is selected, the software sends
the shutdown command to the remote computers at the IP addresses that are listed in the
Shutdown Remote Agents window.

When On Battery is selected, the software sends the shutdown command to the remote
computers when the time of the UPS transfer to battery exceeds the specified time.

3 Select the Load Segment that powers the computer.

4 Enter the IP address (IPv4 address or IPv6 address) or host name and then click Add for each
Agent to be shut down.

5 Click OK to save and exit.
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When the shutdown condition is satisfied, the Agent sends a shutdown signal to the selected remote
Agents.

You can view and set the shutdown condition of each UPS according to its actual status
(see Figure 65).

Figure 65. Shutdown Conditions on the Shutdown Settings Window
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Shutdown Devices Monitored by Network Management Card

To shut down devices monitored by the Network Management Card:

1 Select SNMP from the serial ports list (see Figure 66).

The UPS list displays the IP addresses for all of the devices monitored by the card.

2 Select one device to set the shutdown parameters.

NOTE: The SNMP shutdown function is available only in the local Agent shutdown setting.

Figure 66. SNMP List
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Redundant UPS Shutdown

If there is a redundant UPS supplying power to the local Agent, you can safely shut down the local
Agent before all UPSs shut down. Figure 67 shows a redundant UPS configuration.

Server powered from two redundant
power supplies

AC

AC

RS232 / USB / SNMP

RS232 / USB / SNMP

Figure 67. Redundant UPS Configuration

Click the Redundant UPS Input Setting button to list all of the UPS devices (see Figure 68). Select the
redundant UPS that has different shutdown conditions by selecting its check box. The system will not
shut down until all the conditions of all selected UPSs are met.

Figure 68. Redundant UPS Input Group
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Entering the UPS Warranty Period

Select UPS Warranty Period Setting from the UPS menu to open the UPS Purchase Date Setting
window (see Figure 69).

Figure 69. UPS Purchase Date Setting Window

Enter the UPS Purchase Date, Battery Purchase Date, UPS Warranty Period, and the Battery
Warranty Period.
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You can also remind users of upcoming warranty expiration dates or that the warranty period has
expired.

To remind the user every month that the warranty has expired:

1 Select the Remind user that warranty period expired on check box (see Figure 70).

Figure 70. Monthly Warranty Expiration Warning Settings Example

2 Type or select the day of the month in the Days box.

3 Type or select the time of day in the every month box.

4 Select the Enable Warranty Period warning check box.
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The message displays at the top of the of the UPS status diagram and a reoccurring monthly warning
message displays on the selected day and time (see Figure 71).

Figure 71. Warranty Expiration Warning Message

NOTE: For a one-time warranty expiration message, do not select the Remind user that warranty period

expired on box (see Figure 72).

Figure 72. One-Time Warranty Expiration Warning Settings Example
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Testing the UPS

You can perform a UPS self‐test immediately or schedule a UPS self‐test.

Performing a UPS Self‐Test Immediately

Select Request Battery Test from the UPS menu to open the Request Battery Test window
(see Figure 73).

NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control

commands are restricted to the LCD only. This setting must be enabled from the LCD before you can select

Request Battery Test.

Figure 73. UPS Self‐Test Immediately Window

Select the Self‐Test option and click OK to start the UPS self‐test.

Click Cancel Current UPS Self‐Test from the UPS menu to cancel the self‐test process immediately.
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Scheduling a UPS Self‐Test

Select Battery Self‐Test Schedule from the UPS menu to open the UPS Test Manager window
(see Figure 74). You can schedule a UPS self‐test for one time only or on a monthly basis.

Figure 74. UPS Test Manager Window

The UPS Test Manager window displays a calendar at the top and the task list at the bottom. All of the
UPS self‐test and UPS on/off tasks are shown in the task list. The calendar displays a red dot for the UPS
power off action, a green dot for the UPS power on action, and a blue dot for the UPS self‐test action.
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To schedule a UPS self‐test:

1 Click Add Test to open the UPS Self‐Test window (see Figure 75).

Figure 75. UPS Self‐Test Window

2 Select how often to perform the UPS self‐test: Once or Monthly.

3 Select the start date and time for the UPS self‐test.

NOTE: The scheduled date and time cannot conflict with another scheduled UPS task.

4 Select the Self‐Test option.

5 Select the UPS to test.
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6 Click OK to save and exit.

NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control

commands are restricted to the LCD only. A read-only access message displays when you click OK.

(see Figure 76). You must enable this setting from the LCD before you can apply changes to the UPS Self-Test

window.

Figure 76. UPS is Set to Read-Only Message

The UPS Test Manager window displays the task with a blue dot on the scheduled day and lists
the detailed information in the task list (see Figure 77).

Figure 77. UPS Test Manager Window
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Changing a Scheduled UPS Self‐Test

To modify a scheduled UPS self‐test:

1 Select one of the UPS self‐test tasks in the task list.

2 Click Modify and then update the schedule (see Figure 78).

3 Click OK to save and exit.

Figure 78. Modify Task
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Removing a Scheduled UPS Self‐Test

To remove a scheduled UPS self‐test:

1 Select a UPS self‐test from the task list.

2 Click Remove to cancel the task (see Figure 79).

Figure 79. Remove Task
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Turning the UPS On/Off

You can remotely turn the UPS off and on using the Dell UPS Management Software.

Scheduling a UPS On/Off Task

Select UPS On/Off Schedule from the UPS menu to open the UPS On/Off Manager window
(see Figure 80). You can schedule a UPS On/Off task for one time only or on a weekly basis.

Figure 80. UPS On/Off Manager Window

The UPS On/Off Manager window displays a calendar at the top and the task list at the bottom. All of
the UPS self‐test and UPS on/off tasks are shown in the task list. The calendar displays a red dot for the
UPS power off action, a green dot for the UPS power on action, and a blue dot for the UPS self‐test
action.
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To schedule a UPS On/Off task:

1 Click Add UPS On/Off to open the UPS On/Off window (see Figure 81).

Figure 81. UPS On/Off Window

2 Select how often to perform the UPS On/Off task: Once or Weekly.

3 Select the start dates and times for the UPS On/Off tasks.

NOTE: The scheduled date and time cannot conflict with another scheduled UPS task.

The UPS Power Off time range (from shutdown to next startup) is 1 to 9999 minutes (the
maximum time is 6 days, 22 hours, and 39 minutes). The range for the year is 2009–2035.

4 Select the UPS to turn off and on.
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5 Click OK to save and exit.

NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control

commands are restricted to the LCD only. A read-only access message displays when you click OK.

(see Figure 82). You must enable this setting from the LCD before you can apply changes to the UPS On/Off

window.

Figure 82. UPS is Set to Read-Only Message

The UPS On/Off Manager window displays the task with a red or green dot on the scheduled day
and lists the detailed information in the task list (see Figure 83).

Figure 83. UPS On/Off Manager Window
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Changing a Scheduled UPS On/Off Task

To modify a scheduled UPS On/Off task:

1 Select one of the UPS On/Off tasks in the task list.

2 Click Modify and update the schedule (see Figure 84).

3 Click OK to save and exit.

Figure 84. Modify a Scheduled UPS On/Off Task
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Removing a UPS On/Off Task

To remove a scheduled UPS On/Off task:

1 Select a UPS On/Off task from the task list.

2 Click Remove to cancel the task (see Figure 85).

Figure 85. Remove Scheduled UPS On/Off Task
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Viewing Scheduled Tasks

Select View Schedule from the UPS menu or click the  icon from the toolbar to open the View
Schedule window (see Figure 86). The View Schedule window displays only the tasks for the current
month. Select another month to display the tasks for that month.

Figure 86. View Schedule Window
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Remotely Controlling a UPS on the LAN or Internet

You can remotely monitor any Dell UPS within the same LAN or on the Internet. Up to 32 remote
Agents can be monitored.

NOTE: To remotely monitor any Dell UPS within the same LAN, the computers involved must have TCP/IP

communication protocol.

NOTE: To remotely monitor any Dell UPS on the Internet, the computers involved must have TCP/IP

communication protocol and must be connected to the Internet.

To remotely control a UPS:

1 Test the performance of the physical network communication:

From a command prompt, enter the ping command with the IP address of the computer to be
monitored. Figure 87 shows that the physical link is in an optimal state.

Figure 87. Pinging the Computer to be Monitored
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2 Enable the Accept Remote Control option in the Dell UPS Management Software:

Select Accept Remote Control from the Monitor menu (see Figure 88).

Figure 88. Accept Remote Control

The Dell UPS Management Software window opens (see Figure 89).

Figure 89. Dell UPS Management Software Window
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3 Select a UPS to monitor:

Select the UPS from the tree view on the left side of the window or select Monitor Remote UPS
from the Monitor menu.

If you selected the UPS from the tree view, continue to Step 5.

If you selected Monitor Remote UPS, continue to Step 4.

4 The Monitor Remote UPS window opens (see Figure 90).

Enter an IP address (either IPv4 or IPv6 address) or host name of the Agent and then click OK.

Figure 90. Monitor Remote UPS Window

5 The UPS name displays in the tree view directory (in the LAN directory for LAN connections or in
the WAN directory for Internet connections).

If the Accept Remote Control option of the Agent is off, you can only remotely monitor the UPS.
All control functions are disabled (see Figure 91).

Figure 91. Control Functions Disabled
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If the Accept Remote Control option of the Agent is on, you can remotely monitor and control the
UPS. All control functions are available (see Figure 92).

Figure 92. Control Functions Enabled

You can manually delete a remote Agent by right‐clicking the selected Agent and clicking Delete
(see Figure 93).

Figure 93. Delete Remote Agent
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Monitoring a UPS through SNMP

You can use SNMP to monitor UPSs that have a Network Management Card installed. Up to 1,000
SNMP nodes can be monitored.

To add an area to the SNMP node:

1 Select the SNMP node from the tree view on the left side of the window.

2 Click Add Area from the SNMP menu.

3 Enter the geographic address of the SNMP card and click OK (see Figure 94).

Figure 94. Add Area Window
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The new area displays under the SNMP node in the tree view (see Figure 95).

Figure 95. New SNMP Area
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To add devices:

1 Click Search Device from the SNMP menu.

2 Select the Internet Protocol Version supported by SNMP from the Protocol Type list
(see Figure 96).

NOTE: The Protocol Type list displays only if both IPv4 and IPv6 are enabled.

NOTE: For IPv4, both single device and segment devices searches are supported.

3 IPv4 only. Enter an IPv4 address in the Start IP field and the End IP field (see Figure 96).

Figure 96. Search Device Window (IPv4)
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4 IPv6 only. Enter the device's IP address (see Figure 97).

NOTE: If the IPv6 address is a broadcast IP, all Network Management Cards that support IPv6 within the LAN

are found. The default IPv6 address is broadcast IP ff02::1.

Figure 97. Search Device Window (IPv6)
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5 Click Search.

After searching, the new device displays in the tree view (see Figure 98).

Figure 98. New Device in SNMP Area

NOTE: If one or more SNMP IP addresses in the search range are disabled, a pop-up window opens displaying

the disabled IP addresses (see Figure 99). Select the IP address to go to the Network Management Card's Web

page and configure the SNMP IP settings to enable the IP address.

Figure 99. Disabled IP Address Window
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6 Double‐click the new device node to connect it with the Internet browser of the Network
Management Card (see Figure 100). The Link column indicates successful communication.

Figure 100. Successful Link
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7 To view the event records for any Dell UPS monitored by a Network Management Card, select the
UPS under the SNMP node in the tree view and select SNMP Event Log from the SNMP menu.
The Event Log for the selected UPS opens (see Figure 101).

Figure 101. Event Log

8 To set the maximum Event Log file length for any Dell UPS monitored by the Network
Management Card, select Event Log Setting from the SNMP menu. The default file length is
5,000 rows, and the maximum value is 100,000 rows (see Figure 102).

Figure 102. Event Log Setting Window
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Rebooting Computers after a Utility Failure

You can reboot individual computers or all computers on the LAN automatically after a utility power
failure.

To configure the computers to reboot when the utility power restores:

1 Select Wake Up from the UPS menu to open the Wake on LAN window (see Figure 103).

Figure 103. Wake on LAN Window

2 To reboot all computers, select the Select all check box and click OK.

3 To reboot individual computers:

� Enter the MAC address for the computer. You can use the ipconfig –all command to identify
the MAC address of the computer.

NOTE: DO NOT enter the dash (‐) of the MAC address.

� Click Add.

� Repeat for each computer that should be rebooted when the utility power restores.

4 Dell recommends to test the reboot function.

To test the reboot function, select the computers from the list and click Test. The computers
should reboot.
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Exporting Configuration Parameters

Instead of configuring the software settings individually on multiple computers, you can easily copy the
software configuration parameters to another computer.

To copy the configuration parameters to another computer:

1 From the configured Agent, select Export Configuration from the System menu (see Figure 104).

Figure 104. Export Configuration

The software exports a file that contains the saved configuration parameters, such as local UPS
information, Network Management Card settings, shutdown parameters, and alarm settings.

2 Save the *.ini file.
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3 From the new Agent, select Import Configuration from the System menu (see Figure 105).

4 Select the *.ini file and click OK.

Once the configuration parameters are imported, the settings take effect immediately.

Figure 105. Import Configuration
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Event Descriptions
This chapter lists events logged by the Dell UPS Management Software (see “Viewing the Event Log”
on page 41). Events can be set up to send an event message through broadcasting, e-mail, and text
messaging. Some events can also be sent as a page to configured pagers, or set up to open a message
window on your computer. See “Configuring Event Actions” on page 44.

Number Event Description Type of Message Remarks

1 UPS Battery Low Serious In the Shutdown Settings, select
UPS Battery Low so that when
this event occurs, the UPS shuts
down according to the shutdown
parameters.

2 UPS Output Overload Serious Output load is more than 110%.

3 Communication Lost Warning The communication cable is not
connected, or there is a
communication port fault.

4 AC Fail Warning

5 On Bypass Warning The UPS transfers to Bypass
mode because of overload,
hardware fault, or other
conditions. An online UPS is
also in Bypass mode when it is
off, at which time the UPS
provides no protection.

6 Battery Test Fail Warning

7 AC Restore Information

8 Communication Established Information

9 Agent Start Information

10 Agent Stop Information

11 System to be Shut Down Information

12 System to be Shut Down by
Another Agent

Information Set the Agent to respond to
through Shutdown Settings.

13 Specific Date UPS Shutdown Information

14 Weekly UPS Shutdown Information

15 Self‐Test Started Information Self‐test begins immediately.

16 Self‐Test Canceled Information

5
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Number RemarksType of MessageEvent Description

17 Self‐Test Ended Information

18 Specific Date Self‐Test Started Information

19 Specific Date Self‐Test
Canceled

Information

20 Specific Date Self‐Test Ended Information

21 Monthly Self‐Test Started Information

22 Monthly Self‐Test Canceled Information

23 Monthly Self‐Test Ended Information

24 UPS Control Power ON none

25 On Manual Bypass Alarm only Applies to 5600W and
double‐conversion UPS models
only.

26 In High Efficiency Mode none Applies to double‐conversion
UPS models only.

27 ON Buck / Input Voltage
Reducer

none

28 ON Boost / Input Voltage
Booster

none

29 ABM State Charging none

30 ABM State Floating none

31 ABM State Resting none

32 ABM State OFF none

33 Clock Set Done none

34 To Bypass Command none Applies to 5600W and
double‐conversion UPS models
only.

35 From Bypass Command none Applies to 5600W and
double‐conversion UPS models
only.

36 UPS On Command none

37 UPS Off Command none

38 Battery Disconnected Alarm only

39 Shutdown Imminent Alarm only
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Number RemarksType of MessageEvent Description

40 Service Battery Alarm and disables battery
charging (ABM in Charger Off
mode)

41 Utility Not Present Alarm and transfers to battery if
supporting the load; otherwise,
powers down

Utility level has fallen below the
Utility Not Present threshold
(typically < 25 to 50V).

42 Bypass Not Available Alarm and inhibits bypass
transfer

Applies to 5600W and
double‐conversion UPS models
only.

43 Input AC Overvoltage Alarm and transfers to battery if
supporting the load; otherwise,
turns off converters

44 Input AC Undervoltage Alarm and transfers to battery if
supporting the load or powers
down if not

45 Input Under/Over Frequency Alarm and transfers to battery if
supporting the load

46 Site Wiring Problem Alarm only

47 Remote Emergency Power Off Alarm and de‐energizes load and
enters standby mode

48 Overload L2 Alarm and then transfers to
bypass in 2 minutes

49 Overload L3 Alarm and then transfers to
bypass in 30 seconds

50 Battery DC Overvoltage Alarm only

51 Charger Failure Alarm only

52 Inverter AC Overvoltage Alarm and then transfers to
bypass if supporting the load or
if converters are off

Applies to double‐conversion
UPS models only.

53 Inverter AC Undervoltage Alarm and transfers to bypass if
supporting the load or if
converters are off

Applies to double‐conversion
UPS models only.

54 Rectifier Input Overcurrent Alarm and transfers to battery if
supporting the load or if
converters are off

Applies to double‐conversion
UPS models only.

55 Inverter Output Overcurrent Alarm and transfers to bypass if
supporting the load or if
converters are off

Applies to double‐conversion
UPS models only.
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Number RemarksType of MessageEvent Description

56 DC Link Overvoltage Alarm and transfers to bypass if
supporting the load or if
converters are off

Applies to double‐conversion
UPS models only.

57 DC Link Undervoltage Alarm and transfers to bypass if
supporting the load or if
converters are off

Applies to double‐conversion
UPS models only.

58 Inverter Fault Alarm and inhibits recovery
attempts

Applies to double‐conversion
UPS models only.

59 Rectifier Fault Alarm and inhibit recovery
attempts

Applies to double‐conversion
UPS models only.

60 Output Short Circuit Alarm

61 Heatsink Overtemperature Alarm and transfer to bypass if
supporting the load or if
converters are off

62 Fatal EEPROM Fault Alarm only

63 Fan Failure Alarm only

64 DC Link Imbalance Alarm and transfers to bypass if
supporting the load or if
converters are off

Applies to double‐conversion
UPS models only.

65 Bypass Over/Under Frequency Alarm only

66 Warranty Period Has Expired Information

67 Warranty Period Is Less Than
One Year

Information

68 Output Off Alarm only

69 Output Normal Information
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Installation on a VMware ESX Server
This guide describes the installation and configuration of the Dell UPS Management Software on a
VMware® ESX® Server.

Dell UPS Management Software allows you to connect a 3.x or 4.x VMware ESX Server with a UPS
through the UPS RS‐232 port, USB port, or through the Network Management Card. The software will
be monitored and configured by a remote Agent on either a Microsoft Windows or Linux platform (see
Figure 106).

The software notifies the VMware server of power events or UPS alerts with pop‐up broadcast
information on the console. It also safely shuts down the VMware ESX server and the guest operating
system.

Before the VMware ESX system shuts down, use the shutdown.sh script to shut down the guest
operating system.

All operations are tested on VMware server with two guest operating systems (SBS 2003 and Red Hat)
when the certain conditions exist, such as:

� UPS Battery is low

� Battery backup time is reached

� Battery discharge time is reached

Tested operations include:

� Safely shuts down the VMware server

� Safely shuts down the guest operating system

� Software notifies the VMware server of power events or the UPS alerts

6
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Figure 106 shows an overview of the VMware environment.

Dell UPS

Virtual/
Guest OS1
(Windows)
Applications,
Services, etc.

Virtual/
Guest OSn
(Solaris)

Applications,
Services, etc.

Virtual/
Guest OS2

(Linux)
Applications,
Services, etc.

VMware Server ESX Server
Dell Software

Agent

RS-232/USB/Network Management Card

Figure 106. VMware ESX Environment Structure Overview
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Installation

This guide provides information about installing and configuring Dell UPS Management Software on a
VMware ESX server and installing VMware Tools on a guest operating system.

Prerequisites

� VMware ESX Server with 125 MB free space for the software.

� VMware Infrastructure client must be installed on different machine.

Dell UPS Management Software Installation

To install the software:

1 Download the software from the Dell Web site (support.dell.com) or from the CD (F618R A04 or
higher) provided with the UPS.

2 To install the software from the CD, enter the following command:

mount /dev/cdrom /mnt
cd /mnt/Linux
./setup_console.bin

3 To install the software file downloaded from the Dell Web site:

� Go to the location where the software was downloaded.

� Enter tar –zxvf UPSMS_setup_Linux.tar.gz to extract the file.

� Enter ./setup_console.bin to install the software.

4 Enter the installation path: /opt/ups

5 To start the Agent, enter the command:

./agent start
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Installing VMware Tools on a Microsoft Windows Guest

To install the VMware Tools for a Microsoft Windows guest:

1 On the VM Templates page, select the virtual machine template name and then select the
Console tab. The virtual machine console displays (see Figure 107).

Virtual Machine
Template Name

Figure 107. Console Window

2 Insert and start the Microsoft Windows operating system installation CD.
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3 Log in to the guest operating system from the virtual machine console.

4 Select the template name and then right-click and select Install/Upgrade VMware Tools from the
menu (see Figure 108).

Figure 108. Virtual Machine Template Menu
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5 From within the guest operating system, click OK to confirm that you want to install VMware
Tools and launch the Install Shield wizard.

� If auto‐run is enabled in the guest operating system (the default setting for Microsoft
Windows operating systems), a window opens.

� If auto‐run is not enabled, run the VMware Tools installer. Click Start > Run and enter
D:\setup.exe, where D: is the first virtual CD‐ROM drive.

6 Follow the on-screen instructions.

� On Microsoft Windows Server 2003, the SVGA driver is installed automatically, and the
guest operating system uses it after it reboots.

� After you install VMware Tools, Microsoft Windows 2000 and Microsoft Windows XP guest
operating systems must be rebooted to use the new driver.
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Installing VMware Tools on a Linux Guest

The VMware Tools installation package is on the VMware server installation CD on the path
\VMware\RPMS.

1 On the VM Templates page, select the virtual machine template name and then select the
Console tab. The virtual machine console displays (see Figure 109).

Virtual Machine
Template Name

Figure 109. Console Window
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2 Insert and start the VMware server installation CD.

3 Log in to the guest operating system from the virtual machine console (see Figure 110).

Figure 110. Console Window – Log In

4 Select the template name and then right-click and select Install/Upgrade VMware Tools from the
menu (see Figure 108).

5 Mount the CD with the command:

mount /dev/cdrom /mnt

6 Install the package with the command:

cd /mnt/VMware/RPMS
rpm –Uvh VMware‐esx‐tools‐3.5.0‐123630.i386.rpm

NOTE: The package name is likely to be different.
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7 Configure the VMware Tools with the command:

vmware‐config‐tools.pl

8 Enter number: 1

9 Start the VMware Tools with the command:

vmware‐toolbox &

VMware Tools on the summary row displays OK if the tools are available (see Figure 111).

OK indicates
that VMware

Tools are
available.

Figure 111. VMware Tools Available
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Configuration

This section explains configuration for the Dell UPS Management Software and for the VMware server.

VMware Server Configuration

All hardware elements must have an operational network configuration that allows them to
communicate freely with each other. Dell UPS Management Software uses TCP and UDP for
communication with UPS.

To configure the VMware Server:

1 Confirm that the following UDP ports are opened on the ESX server Firewall. Check the ports
according to the following table:

Communication Mode Ports

USB/RS-232 2198, 2199, 2200

Network Management Card 161, 162, 3369

Example command:

esxcfg‐firewall ‐o 2198,udp,in,UPSMS

2 Confirm that the following TCP ports are opened on the ESX server Firewall: 2099

Example command:

esxcfg‐firewall ‐o 2099,tcp,in,UPSMS

3 If you want to disable the firewall permanently, enter the command:

chkconfig iptables stop

4 To disable the firewall temporarily, enter the command:

service iptables stop
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Communication Through an RS-232 or USB Port

NOTE: USB communication is only available for VMware ESX 4.0.

The VMware server works in console mode and cannot be used for configuration. Use a remote Agent
with the same Dell UPS Management Software version to configure the VMware server.

1 Start the manager interface on the remote software Agent in the Microsoft Windows operating
system.

2 If the two Agents are in the same LAN, the VMware server client will be added to the topology
automatically; otherwise, add the Agent manually (select Monitor Remote Device from the
Monitor menu).

The software automatically searches for the UPS when the Agent starts for the first time after
installation.

If the search fails:

� Select the VMware Server Agent from the tree view.

� Acting as the Administrator, select Auto Search Device from the System menu. The UPS
connected with VMware Server appears in the LAN tree view (see Figure 112).

Figure 112. UPS Connected to the VMware Server
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3 Select Shutdown Parameter from the UPS menu.

4 On the Shutdown Settings page (see Figure 113):

� Set the battery backup time

� Select the Begin Shutdown Immediately if Battery Low check box

� Select the Run Command File before Shutdown check box

� Set the Shutdown File Max Execution Time. Allow at least 30 seconds for each guest
operating system shutdown.

Figure 113. Shutdown Options
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Communicating Through the Network Management Card

NOTE: See Table 4 on page 133 for a complete list of Dell Command User Interface (CUI) commands.

The following procedure is an example of a user entering the settings for a graceful shutdown of selected
devices through the network management card:

1 Enter the installation path: /opt/ups

2 Enter ./CuiManager to start the CuiManager (see Figure 114).

3 Search for a single device by entering search4 and the device network IP address, or search for
multiple devices within a range.

Example command:

search4 –ip 172.18.127.1 –ip 172.18.127.254 –c public

All devices in the network IP address from 172.18.127.1 to 172.18.127.254 are added.

Figure 114. Searching for Devices
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4 Enter the shutdown commands (see Figure 115).

Example:

shutsys ­ip 172.18.127.47 ­e true

shutbackup ­ip 172.18.127.47 ­e true ­m 1:00

shutfile ­e true ­f shutdown.sh ­m 2

listshut –ip 172.18.127.47

NOTE: See ”Dell CUI Commands” on page 133 for a description of all Dell CUI commands.

NOTE: Each guest operating system requires a minimum of 30 seconds to run the command file before

shutdown. The -m 1 option in the shutfile command in the example below sets one minute as the total time

allowed to run the command file before shutdown, which allows sufficient time for two guest operating systems.

Example: shutfile -e true -f shutdown.sh -m 1

The host and guest operating system shut down orderly and gracefully after the battery discharges
for one minute.

Figure 115. Shutdown Parameters
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Installation on a VMware ESXi Server
This guide describes the installation and configuration of the Dell UPS Management Software on a
VMware® ESXi® Server.

The Dell UPS Management Software agent cannot be installed on the hypervisor system because
VMware® ESXi does not have an administrative console for hypervisor. However, the software can be
installed on VMware Infrastructure Management Assistant (VIMA) 1.0 or on vSphere Management
Assistant (vMA) 4.0 to manage the shutdown of VMware ESXi hosts. You can configure the ESXi to
safely and orderly suspend or shutdown guest operating systems by configuring the ESXi hypervisor.
This allows one Dell Software agent on one guest operating system (VIMA/vMA).

Dell UPS Management Software allows you to connect a 3.x or 4.x VMware ESXi with a UPS through
the Network Management Card.

The software notifies the VMware server of power events or UPS alerts with pop‐up broadcast
information on the console. It also safely shuts down the VMware ESXi server and the guest operating
system.

Before the VMware ESX system shuts down, use the shutdownESXi.sh script to shut down the guest
operating system.

All operations are tested on VMware server with two guest operating systems (SBS 2003 and Red Hat)
when certain conditions exist, such as:

� UPS battery is low

� Battery backup time is reached

� Battery discharge time is reached

Tested operations include:

� Safe shut down of the VMware server

� Safe shut down of the guest operating system

� Notifications of any power events or UPS alerts to the VMware server

7
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Dell UPS

VIMA 1.0/
vMA 4.0

Virtual/
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Figure 116. VMware ESXi Environment Structure Overview
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Installation and Configuration

This guide provides information about installing and configuring the Dell UPS Management Software
on a VMware ESXi server and installing VMware Tools and vMA 4.0 on a guest operating system.

Prerequisites

� VMware ESXi server machine

� VIMA 1.0 or vMA 4.0 installed as guest

� VMware Infrastructure client installed on a different machine for VMware ESXi Server
configuration

� Secure Copy Protocol (SCP) client like WinSCP to upload packages to the VMware ESXi server

� Dell UPS Management Software installed on the vMA

vMA Installation

To install the vMA application:

1 Go to http://www.vmware.com/support/developer/vima/ to download the software from the
VMware Web site.

2 Unzip the vMA virtual application package.

3 Start the VMware Infrastructure client:

� Select File > Deploy OVF Template.

� Click Browse.

� Select the Open Virtualization Format (OVF) and click Next.
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vMA Configuration

To configure the vMA software:

NOTE: The default user name is vi­admin.

1 Enter the following command to add Target Servers to vMA:

sudo vifp addserver <servername>

Example command: sudo vifp addserver 172.18.127.11

2 Enter the following command to enable seamless authentication for remote CLI and VI Perl
Toolkit:

Example command: sudo vifpinit 172.18.127.11

3 Verify that the target server has been added. Enter the following command to display target
servers:

sudo vifp listservers

Example response: 172.18.127.11 ESXi

VMware ESXi Server Configuration

To allow interactions between physical and virtual machines, VMware tools must be installed on each
virtual machine. Go to http://www.vmware.com/pdf/osp_install_guide.pdf to download the VMware
Tools Installation Guide Operating System Specific Packages on the VMware Web site for further
information.



121
 

Installation on a VMware ESXi Server |

Installing VMware Tools on a Microsoft Windows Guest Operating System

To install the VMware Tools for a Microsoft Windows guest operating system:

1 On the VM Templates page, select the virtual machine template name and then select the
Console tab. The Console window opens (see Figure 117).

Virtual Machine
Template Name

Figure 117. Console Window

2 Insert and start the Microsoft Windows operating system installation CD.
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3 Log in to the guest operating system from the virtual machine console.

4 Select the template name and then right-click and select Guest>Install/Upgrade VMware Tools
from the menu. (see Figure 118.)

Figure 118. Virtual Machine Template Menu



123
 

Installation on a VMware ESXi Server |

5 From within the guest operating system, click OK to confirm that you want to install VMware
Tools and launch the Install Shield wizard.

� If auto‐run is enabled in the guest operating system (the default setting for Microsoft
Windows operating systems), a window opens.

� If auto‐run is not enabled, run the VMware Tools installer. Click Start > Run and enter
D:\setup.exe, where D: is the first virtual CD‐ROM drive.

6 Follow the on-screen instructions.

� On Microsoft Windows Server 2003, the SVGA driver is installed automatically, and the
guest operating system uses it after it reboots.

� After you install VMware Tools, Microsoft Windows 2000 and Microsoft Windows XP guest
operating systems must be rebooted to use the new driver.
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Installing VMware Tools on a Linux Guest Operating System

To install the VMware Tools for a Linux guest operating system:

1 On the VM Templates page, select the virtual machine template name and then select the
Console tab. The Console window opens (see Figure 119).

Virtual Machine
Template Name

Figure 119. Console Window

2 Insert the VMware server installation CD.

Go to \VMware\RPMS to locate the VMware Tools installation package.

3 Log in to the guest operating system from the virtual machine console (see Figure 120).
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Figure 120. Console Window – Log In

4 Select the template name and then right-click and select Install/Upgrade VMware Tools from the
menu. (see Figure 118.)

5 Mount the CD with the command:

mount /dev/cdrom /mnt

6 Install the package with the command:

cd /mnt/VMware/RPMS
rpm –Uvh VMware‐esx*.rpm

NOTE: The package name is likely to be different.

7 Configure the VMware Tools with the command:

vmware‐config‐tools.pl

8 Enter number: 1
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9 Start the VMware Tools with the command:

vmware‐toolbox &

VMware Tools on the summary page displays OK if the tools are available (see Figure 121).

OK indicates
that VMware

Tools are
available.

Figure 121. VMware Tools Available
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VIMA/vMA Shutdown and Startup Configuration

NOTE: You can configure the physical machine to boot the automatic operating system on startup. This setting

is located in your machine’s basic input/output system (BIOS). For further information, refer to your specific

technical hardware documentation.

NOTE: You can configure the automatic startup and shutdown properties of guest operating systems as

suspended.

� Automatic Shutdown of guest (VIMA/vMA) when ESXi host is shutting down and

� Automatic Startup of guest (VIMA/vMA) when ESXi host is starting

To configure VIMA/vMA shutdowns and startups:

1 Choose the host server from the left pane tree hierarchy by the Virtual Infrastructure Client
interface and then select the Configuration tab.

2 Select Virtual Machine Startup/Shutdown” from the Software list and click Properties. The
Virtual Machine Startup and Shutdown window opens (see Figure 122).
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3 Enter the settings as shown on the Virtual Machine Startup and Shutdown window:

� For each virtual machine, set delay startup for 10 seconds

� For each virtual machine,  set delay shutdown for 30 seconds

Figure 122. Startup/Shutdown Settings
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NOTE: All hardware elements must have an operational network configuration that allows them to

communicate freely with each other. The Dell UPS Management Software uses TCP and UDP for

communication with UPS.

4 Confirm that the following UDP ports are enabled on the VIMA/vMA firewall: 161, 162, and 3369

Example commands:

sudo iptables ­I INPUT ­p udp ­­dport 161 ­j ACCEPT

sudo iptables ­I OUTPUT ­p udp ­­dport 161 ­j ACCEPT

5 Confirm that the following TCP port is enabled on the VIMA/vMA firewall: 2099

Dell UPS Management Software Installation

To install the software:

1 Start the vMA 4.0 guest operating system.

2 Download the software from the Dell Web site (support.dell.com) or from the CD (F618R A04 or
higher) provided with the UPS.

3 Upload the software from Windows to vMA 4.0 using WinSCP tools.

4 Copy the Linux and InstallerData files from the CD to vMA.

5 Enter the following commands to access the Linux and InstallerData files:

sudo chmod ­R 777 Linux

sudo chmod ­R 777 InstallerData

6 Enter the Linux path and then enter the following command to install the software:

cd Linux

sudo ./setup_console.bin

7 Edit the document “VMwareESXHosts” on the installation path.

Add all ESXi server host IP addresses, separated by spaces. Add the IP address of the ESXi server
on which VIMA/vMA is installed as the last entry.

Example: 172.18.127.13 172.18.127.12 172.18.127.11

NOTE: To configure each server, see “vMA Configuration” on page 120.

8 Start the Agent. From the installation path, enter the command:

sudo ./agent start
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Shutdown Parameter Setting for Network Management Card

The following procedure is an example of entering the settings through the network management card
for a graceful shutdown of selected devices.

NOTE: See Table 4 on page 133 for a complete list of Dell Command User Interface (CUI) commands.

1 Go to the installation path.

2 Enter ./CuiManager to start the CuiManager (see Figure 123).

3 Search for a single device by entering search4 and the device network IP address, or search for
multiple devices within a range.

For example:

search4 –ip 172.18.127.1 –ip 172.18.127.254 –c public

All devices in the network IP address from 172.18.127.1 to 172.18.127.254 are added.

Figure 123. Searching for Devices
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4 Enter the shutdown commands (see Figure 124).

Example:

shutsys ­ip 172.18.127.47 ­e true

shutbackup ­ip 172.18.127.47 ­e true ­m 1:00

shutfile ­e true ­f /opt/ups/shutdownESXi.sh ­m 2

listshut –ip 172.18.127.47

NOTE: See ”Dell CUI Commands” on page 133 for a description of all Dell CUI commands.

NOTE: Each guest operating system requires a minimum of 30 seconds to run the command file before

shutdown. The -m 1 option in the shutfile command in the example below sets one minute as the total time

allowed to run the command file before shutdown, which allows sufficient time for two guest operating systems.

Example: shutfile -e true -f /opt/ups/shutdownESXi.sh -m 1

Figure 124. Shutdown Parameters
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The host server and guest operating system shut down orderly and gracefully after the battery
discharges for one minute. The status is displayed in the Recent Tasks pane at the bottom of the
window (see Figure 125).

Figure 125. Recent Tasks Pane – Shutdown Confirmation
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Dell CUI Commands List

The Dell Command User Interface (CUI) is a client program that connects to the Dell Monitor Server.
The program operates only on SNMP devices and is used only on operating systems that support
character commands. The Dell CUI is primarily used to search for SNMP devices and to set operating
system shutdown parameters. Table 4 lists the Dell CUI commands.

Table 4. Dell CUI Commands

Command Description

del Purpose: Delete SNMP device

Format: del target_ip [[target_ip]]

Example: del 172.18.128.32

help Purpose: List all CUI commands

Format: help

import Purpose: Import batch files and execute commands

Format: import target_file

Example: import mybatch.txt

list Purpose: List all SNMP devices connected to monitor

Format: list

listshut Purpose: List shutdown parameter messages

Format: listshut [­ip target_ip]

Option:

­ip target_ip: IPv4 or IPv6 address

Examples:

listshut ­ip 172.18.127.123 (list messages for one device)

listshut (list messages for all devices)

powerby Purpose: Show or Set message of "Powered by"

Format: powerby [­ip target_ip] [­s count]

Options:

­ip target_ip: IPv4 or IPv6 address

-s count: Segment 1 or 2

Example: powerby ­ip 172.18.127.25 ­s 1

quit Purpose: Exit CUI

Format: quit
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DescriptionCommand

redundant Purpose: Show, Add, or Remove IP for "Redundant UPS Input Setting"

Format: redundant [­r] [[target_ip]]

Option:

-r Removes redundant SNMP devices

Examples:

redundant 172.18.128.32 172.18.127.50 (add redundant ip)

redundant ­r (remove all redundant ip)

redundant (list all redundant IP messages)

search4 Purpose: Search IPv4 SNMP devices

Format: search4 [ip target_ip] [­ip target_ip] [­c community]

Options:

­ip target_ip: IPv4 address (default is 255.255.255.255)

­c community SNMP communication authorization (default is public)

Examples:

search4 ­ip 172.18.127.1 ­ip 172.18.127.254 ­c public

search4 (using default options value)

search6 Purpose: Search IPv6 SNMP devices

Format: search6 [­ip target_ip] [­c community]

Options:

­ip target_ip: IPv6 address (default is ff02::1)

­c community SNMP communication authorization (default is public)

Examples:

search6 ­ip ff02::1 ­c public

search6 (using default option value)

shutbackup Purpose: Show or Set message of "Allow battery to discharge for"

Format: Usage: shutbackup [­ip target_ip] [­e boolean] [­m time]

Options:

­ip target_ip: IPv4 or IPv6 address

­e boolean: true ­ enable, false ­ disable

­m time: minute:second (range 0:0 ­ 999:59)

NOTE  No options show relative messages of device.

Example: shutbackup ­ip 172.18.127.123 ­e true ­m 10:10
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DescriptionCommand

shutfile Purpose: Show or Set message of "Run Command File before Shutdown"

Format: shutfile [­e boolean] [­f file] [­m time]

Options:

­e boolean: true ­ enable, false ­ disable.

­f target_file: Execute file name before shutdown

­m time: minute: (range 1 ­ 60)

NOTE  No options show relative messages of device.

Example: shutfile ­e true ­f abc.bat -m 2

shutlow Purpose: Show or Set message of "Begin Shutdown Immediately if Battery Low"

Format: shutlow [­ip target_ip] [­e boolean]

Options:

­ip target_ip: IPv4 or IPv6 address

­e  boolean: true ­ enable, false ­ disable

NOTE  No options show relative messages of device.

Example: shutlow ­ip 172.18.127.123 ­e true

shutremain Purpose: Show or Set message of "Shut down when remaining battery time is below"

Format: shutremain [­ip target_ip] [­e boolean] [­m time]

Options:

­ip target_ip: IPv4 or IPv6 address

­e boolean: true ­ enable, false ­ disable

­m time: minute:second (range 0:0–999:59)

NOTE  No options show relative messages of device.

Example: shutremain ­ip 172.18.127.123 ­e true ­m 10:10

shutsys Purpose: Show or Set message of "System"

Format: shutsys [­ip target_ip] [­e boolean]

Options:

­ip target_ip: IPv4 or IPv6 address.

­e  boolean: true ­ enable, false ­ disable

NOTE  No options show relative messages of device.

Example:

stopsearch Purpose: Stop searching thread

Format: stopsearch
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